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SCAN'R, LICENSE AGREEMENT

This user license agreement (the "AGREEMENT") is an agreement between you (individual or single entity)

and Binary Acoustic Technology LLC, for the SCAN’ Rym, software (the "SOFTWARE") that is accompany-
ing this AGREEMENT. USE OF THIS PRODUCT CONSTITUES YOUR ACCEPTANCE OF THESE
TERMSAND CONDITIONS.

The SOFTWARE isthe property of Binary Acoustic Technology LLC and is protected by copyright laws and
international copyright treaties. The SOFTWARE is not sold, it islicensed.

PRODUCT VERSION

If you accepts the terms and conditions of this AGREEMENT, you have certain rights and obligations as fol-
low:

YOU MAY:

1. Ingtal and use one (1) primary copy of the PRODUCT VERSION on a computer and one (1) backup
copy on alaptop or mobile computer.

YOU MAY NOT:

1 Sublicense, rent or lease the PRODUCT VERSION or any portion of it.

2. Decompile, disassemble, reverse engineer or modify the PRODUCT VERSION or any portion of it.
3. Distribute copies of the PRODUCT VERSION without written consent from an authorized represen-

—+

ative of Binary Acoustic Technology
TRANSFER OF LICENSE

Y ou may transfer your license to another individual or single entity on a permanent basis provided
that you retain no copies and the recipient agrees to the terms of this Agreement. Notice must be given by you
to Binary Acoustic Technology that such atransfer has taken place.

WARRANTY DISCLAIMER

The SOFTWARE issupplied " ASIS". Binary Acoustic Technology LL C disclaimsall
warranties, expressed or implied, including, without limitation, the warranties of mer-
chantability and of fitnessfor any purpose. The user must assumethe entirerisk of
using the SOFTWARE.

DISCLAIMER OF DAMAGES

Binary Acoustic Technology L L C assumes no liability for damages, direct or conse-
quential, which may result from the use of the SOFTWARE, even if Binary Acoustic
Technology LLC hasbeen advised of the possibility of such damages. Any liability of
the seller will belimited to refund the purchase price.



Chapter 1: Installation

1.1 : What you should havereceived

1.2:

1.3:

The SCAN'’ Ry, package includes one SCAN’ Ry,, CD-ROM
and thismanual. The CD-ROM contains the software distri-
bution along with a setup function that uses the Microsoft
Windows installer.

New | nstallation

Place the CD-ROM in the drive. After ashort delay the CD-
ROM window should open. If this does not happen, double-
click the CD-ROM symbol in the My Computer folder.

When the CD-ROM window appears double click the Setup

icon. Thiswill bring up the Window Installer. Follow the
directions to complete the installation.

Updating an Older Version

Follow the same procedure as described in the section 1.2.

For reasons of safety it is good practice to create a backup
of your previous data before proceeding.

Itisalso recommended to uninstall older versions of
SCAN'R beforeinstalling new versions.



Chapter 2: SCAN’' Ry
2.1: Introduction

SCAN'’ Ryy, is an automated snapshot characterization and analysis
tool. Itisdesigned to help address two main issues present in bat
monitoring projects, namely 1) handling the high volume of data
that is produced by modern Time Expanded (TE) and Full Band-
width (FB) bat detectors, and 2) converting the recordingsinto
meaningful measurements that can potentially be used to identify
individual species and estimate populations.

First, SCAN’ Ry includes anovel bat detection technique that can
distinguish between actual bat calls and false alarms which are due
to insects and other noise sources. This featureisfully automated.
SCAN'’ Ry, Will process an entire snapshot directory and separate
thefilesinto two lists, alist of “passed” filesthat contain bat calls
and alist of “failed” filesthat don't. Afterward, with a single but-
ton click, the operator can either delete all of the failed files or save
all the passed filesinto a separate archive directory.

Second, SCAN'’ Ry, includes a fully automated characterization
processor which isolates each bat vocalization and measures the
relevant vocalization parameters. It supports two different base pa-
rameter sets. It currently produces base parameter sets that con-
form to both Anal ook, and SonoBat;, protocols. In addition
SCAN'’ Ry, supports afew enhanced parameter measurements in-
cluding Signal Pressure Level (SPL) and curvature, a spectral shape
measurement.

These two processing features can be employed to scan though vol-
umes of recorded data and extract/archive only the files of interest.



Chapter 3: Running SCAN'R
3.1: Running from desktop

A SCAN'’Ry, desktop icon is created and
placed on your desktop during the install.

You can start SCAN’ Ry, from the desktop

by double clicking on the SCAN’ Ry, icon
illustrated by Figure 1.

Figure 1. SCAN’ Ry, Icon

3.2: Running from Start Menu

SCAN'’ Ry, can also be run from the Sart menu. You can run it
by selecting Start => All Programs => SCANR

3.3 Exiting

There are two ways to exit the program. Thefirst isusing the
red ‘X’ button in the upper right corner of the window. The
other way isusing the File => Exit menu item.



3.4: TheSCAN'R Main Window

Upon startup the main window appears as shown in figure 2.
The main window has two basic sections. The file selection
section (left) alows the operator to select both input and output
files. It can aso be used to manually operate the scanner and
select individual filesto process. The sonogram “thumbnail”
section (right) displays a sonogram for each detected bat call. It
provides quick visual feedback on the progress of the scanner
and allows the operator to inspect the results and/or make meas-
urements of their own. The thumbnail section includes aview
scroll bar (light green) that allows an operator to adjust the
range of thumbnails that are displayed.
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Figure 2: SCAN’ Ry, Main Window



3.4.1: Output File Selector

The output file selector allows the operator to specify the file that
will receive the parameter measurements. Clicking on the

“ Select Output...” button will bring up a standard windows file
selection tool, Figure 3. Thistool allows the operator to browse
existing folders, create new folders and specify an output file-
name.

Keep in mind that the output file is a parameter file. Aseach bat
call is processed, SCAN’ Ry, will measure the relevant parameters
and store them into thisfile using a standard tab delimited pa-
rameter file format. SCAN’ Ry, aso supports two different pa-
rameter base formats along with several different optional pa-
rameters. Use the Output Format sel ection window (section
3.6.1) to select the desired output format.

It is important to note that the output fileis only reset at the time
you select it. After this, the file will be updated with results from
each new scan. Thiswill continue until either anew fileis se-
lected or the same fileisreselected. To rerun a scan, overwriting
the previous results, you must first reselect the output file.
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Figure 3. File selection tool



3.4.2: Input File Selector

The input file selector operates
much the same as the output file
selection. Clicking on the “Select
Input...” button will bring up a
standard file selection window.
However, rather than just selecting
just asinglefile. The Input Selec-
tor will read in and display all of
the filesin the selected directory.
All fileswill be listed and the origi-
nal selected file will be highlighted
assnhown in figure 4.

Please note that the input selection
panel includes a comment display
which is updated with any SPEC-
T’ Rym or SonoBat;,, compatible
comment field that is found in the
selected file.
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Figure4: Input Selection

3.4.2.1: Operating the File Selection Panel

SCAN’ Ry, can be operated using the input file selection panel. Select
theinitial file and directory by clicking on the Select Input button.
Thiswill populate the list with all the files in the selected directory.
Notethat if thefilelist istoo largeto fit in the panel, a scroll bar will
appear to alow the operator to scroll through the entire list. The se-
lected file will be highlighted in blue. To change selection smply
click on another filename in the list box. The new file will be high-
lighted and the comment display will be updated to reflect the new
file. To manually process (or reprocess) asingle file, ssmply double

click on the file name.




3.4.3: Sonogram “ Thumbnail” Display

The thumbnail is a sixteen pane sonographic display that is organized in
four rows and four columns asillustrated in figure 5. The panes are up-
dated with each new detection. Each pane holdsasingle cal. The update
order is left-to-right and top-to-bottom.

The thumbnail display provides visua feedback of the scanner progres-
sion. It provides amouse driven interface to allow the operator to select
thumbnails of interest and inspect the results. The measurement interface
iIssimilar to SPECT’ Ryy,. The display includes measurement readouts at
the bottom of the screen. Simply move the mouse over the desired region
of athumbnail. SCAN’ Ry, senses the position of the mouse and updates
the readouts accordingly. To make differential measurements, click on a
point of interest and then move the mouse. The readout will now show
the difference between the point originaly clicked and the new location of
the mouse.

Figure 5: Thumbnail display



3.4.4: Zooming the“ Thumbnail” Display

Double click the left mouse button to zoom , on any of the sixteen
thumbnails, to get a closer look. When zoomed, the resolution of the dis-
play isincreased and the display is updated with the automated parameter
estimates for that call. Asshown in figure 6, the zoomed thumbnail is
enlarged by nearly afactor of four. To un-zoom, click theright mouse
button.

The zoomed thumbnail now includes parameter measurements in the up-
per right corner . A zoomed sonogram is overlaid with computer gener-
ated tracking and feature identification information to provide the opera-
tor with all of the signal characteristic information in one display. Thisis
useful for checking the performance of the SCAN'’ Ry, against various
types of bat call aswell asfor quick visual species identification.

Please note that the parameter measurements displayed use the same pa-
rameter set format that is selected for the output file.
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o

Figure 6. Thumbnail display



3.4.5: Selecting the Range of Thumbnails

SCAN’R displays only sixteen (16) thumbnails at atime. Asof version
1.2, SCAN’R includes a scrolling feature that allows the operator to select
the range of 16 thumbnailsto display. The scroll bar islocated at the right
side of the thumbnail display group.

Aseach fileis scanned, SCAN’R creates athumbnail for each bat call
that is detected. Once the number of thumbnailsincreases beyond the size
of the display, the scroll bar will turn light green and the scroll display

will be adjusted to indicate the number of thumbnails that are available.
The number of thumbnails that can be created per snapshot islimited to
two hundred. Once SCAN’R reaches thislimit, it will stop generating
thumbnails. The limit only applies to thumbnail generation for display
purposes. Notethat SCAN’R will scan each snapshot to completion and

it will generate parameter measurements for all bat calls detected.

To operate the thumbnail scroll bar, smply click and hold the left mouse
button while the cursor is on top of the light green bar and then drag the
bar to the desired position. The display updates as the bar is moved. This
allows the operator to quickly scan through large numbers of thumbnails.
Once the desired position is reached, simply release the left mouse button
an the display will be updated with the new position.

New feature: One new featurein SCAN’R version 1.2 isthat the scroll
bar can aso be used in zoom mode. Double click athumbnail to bring up
zoom mode. Then, as before, click and hold the left mouse button while
the cursor is on top of the light green bar and then drag the bar. If you
drag the bar slowly enough, the zoom window will display a progression
thumbnails. This allows the operator to inspect a sequence of thumbnails
more easily. Thisisaso agood way to study bat callsin atime-
sequenced “movie mode”.



3.4.6 : Operating Brightnessand Contrast Controls

Simply stated, the Brightness and Contrast controls alow the op-
erator to adjust the screen appearance. Moving either dlider left
reduces the screen brightness/contrast, while moving the slider
right increase the screen brightness/contrast.

To be more precise, the Brightness and Contrast controls actually
control how the underlying sonographic data maps to the screen
color and/or intensity. Explained this way, the brightness and
contrast actual control the level of sonographic detail that will be
mapped to the screen. The brightness control actually establishes
the mean value of the display, while the contrast controls the lin-
ear range or sensitivity around the mean value.

Once you master operation of the brightness and intensity con-
trols, you will find them a great tool to use to discover the subtle
details of bat vocalizations.



3.5: SCAN’'R Menu Operation

3.5.1: FileMenu

The File menu provides 1) an alter-
nate method to select the Input and
Output files and 2) it provides the [N Setup  Action  Window  Help

main mechanism to exit SCAN’R. m
Select Qubput,..

Clicking on either Select Inpt... Exit gt
will bring up a standard windows ——

file selection utility and update the
input file list as described in selec-
tion 3.4.2. Clicking on or Select
Output... will again bring up a stan-
dard selection utility and then up-
date the output file as described in
section 3.4.1.

B SCANR - LCin_rel28_D2005

Figure 7: File Menu

3.5.2: Setup Menu

The Scan Setup menu allowsthe

operator to bring up the three pri-
mary control window. All of these F
windows contain controls that al- File Config Action Window

low the operator to customize the Time Standard
operation of SCAN’ Ry, Scan Setup...

Scan Resulks, .,
The windows operation is de- —  OutputFormat.. ke

scribed in sections that follow.

Note that SCAN' Ry saves all set- Figure 8: Setup Menu
tings and restores them next time
SCAN'’ Ry, isrun.



3.5.3: Action Menu

The Action menu provides options
to start and stop file scanning op-
erations. Action=>Scan initiates a

scan of the currently selected file
(filelist box). Action=>Scan All
initiates scanning of all filesinthe | File Setup window  Help

filelist box. This effectively scans
an entire directory. Action=>30p
terminates the current scanning op-
eration.

Scan

: <Mo File Selected:
Please note that the Stop operation <No File Selecte

Is primarily intended to give the Figure 9: Action Menu
operator a mechanism to abort the

current scanning operation. Nor-

mally thisisjust to test settings or

to rerun the current operation.

3.5.4: Window Menu

Similar to the Scan Setup menu, the

Scan Window menu aso allowsthe
operator to bring up the three pri- Action Help

mary control windows. However, Scan Setup

it also displays a check mark next Scan Results

to the windows that are currently Cutput Format
active et Outpul  cperation Timer. ..

Trace...

The Scan Window is primarily in-

tended to quickly bring active win- Figure 10: Window Menu
dows to the forefront when they are

hidden behind other windows on

the desktop.



3.5.5: Configuration Menu

The configuration menu is a special menu that appears only in
the extended license version of SCAN’R. The configuration
menu provides a mechanism for the operator to select default set-
tings for reading generic wave files.

As of version 1.3.6, the configuration menu allows the operator
to supply the default time expansion factor that will be used to
interpret the sample rate of the file. Two time expansion factors
are supported 1X and 10X. Thefirst, 1X, supports files that were
recorded in real-time using a high speed digitizer. The second,
10X, supports files that were generated using atime expanded

bat detector. If the wav files were recorded with a high speed di-
gitizer or if the files are marked with the actual samplerate,
choose 1X. If the wav files were recorded using atime expanded
detector and a PC audio port, choose 10X.

The default time expansion selection is only applied to generic
wave files. It has no effect on recordings produced by either the
SPECT’R or SonoBat recording software packages. Both of
these place recording setting and other attribute information di-
rectly into the recorded files which SCAN’R will read to deter-
mine the correct time expansion setting.



3.6 : SCAN’'R Setup and Operation Windows

3.6.1: Output Format Window

The Output format window Output Format
controls the format of the output
parameter file. SCAN’ Ry, Sup-
ports two output format options, v g2 Analook(tm] compatible format
an Ana OOktm and a SonoBattm [ Use Sonab at(tm) compatible farmat
compatible base format. It also
allows the base format to be
augmented with additiond pa- v Include Sound Pressure Level
rameters. v Include Curvature

[ Include Curvee Fit Emror

Cutput Format S election

Additional output options

Click on the Setup=>Output
Format... menu entry. Thiswill
bring up the Output Format win- | bat @'

dow asillustrated in figure 11.
Figure 11 : Output Format Window

The top portion of the window contains two check boxes. One box
selects the Anal ook, compatible base format and the other selects
the SonoBat;,, compatible base format. Click on the box next to the
desired selection. The checked box indicates the current selection.
The sdlection is stored and will be remembered the next time
SCAN'’Ryy, is used.

In addition to the standard formats, SCAN’ Ry, is capable of provid-
ing additional measurements. The lower portion of the screen pro-
vides a mechanism for the operator to include these measurementsin
the output format. The sound pressure level option adds a measure-
ment of the peak sound pressure level detected in the call. The Cur-
vatur e selection adds the curvature measurement. Finally, the Cur -
vature Fit Error adds a curve fit metric.

The parameters are described in greater detail in section 3.7.



3.6.2 : Scan Setup Window

The Scan Setup Window is acontrol panel which allows the operator to
setup the scanner and configure the call selection criteria. The control
parameters are separated into two function groups as show in figure 12.
The upper section controlstheinitial call detection criteria, while the
lower section controls the fina call filtering. The primary difference be-
tween the two is that the upper section sets the criteria used to detect the
bat calls in the recording, while the lower section controls the filtering
operation which filters out unwanted detections.

The upper section contains three controls, the trigger level setting, the
minimum and maximum frequency cutoff settings, and the standard
view duration setting. To detect bat calls, SCAN’R tracks the noise
floor of the recording and searches for burst sound energy that is greater
than the noise by at least the value set by the Trigger Level. At the same
time, the scan will regject all sound energy at frequencies lower than the
minimum frequency cutoff setting or higher than the maximum setting.
Thisalow SCAN’'R to immediately reject insects an other sounds that
are out of the ultrasonic frequency range. Once triggered, SCAN’R will
process the burst over duration selected by Standard View setting. The
Standard View duration can be adjusted using adlider. Thisallowsthe
operator to optimize the displays to meet the requirements of different
call types.

The lower section of the Scan Setup Window contains a set of filtering
controls. These controls are the peak power filter, the minimum dura-
tion filter , the fit restriction filter, the pop filter, and a parameter se-
lectivefilter bank . All of thesefilters are applied after the initial call
detection and are used to qualify the detections and/or search for calls
that meet certain criteria

At the very bottom of the Scan Setup Window are two buttons which
allow the operator to load and/or save the currently configured settings.
These are useful for maintaining settings templates for specific scan cri-
teria
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Figure 12 : Scan Setup Window




The peak power filter is used to regject detections that don’t reach are-
guired peak sound pressure level during the duration of thecall. Like
thetrigger level , thissetting is referenced to the current value of the
noise floor. It should be higher than the trigger level by at least 3 dB
(default is set 6dB greater).

The minimum duration filter is used to reject detections that don't last
long enough. Many of the fal se detections due to insects can be consid-
ered “pop” noise. They are very short duration bursts that |ast only frac-
tions of amillisecond. In comparison, even short bat callslast longer
than amillisecond, and echolocation calls are normally even longer.

The minimum duration is defaulted to half amillisecond. Thisvaue has
proven to work well against most bug interference.

Thefit restriction filter is used to reject detections that don’t meet the
selected curvefit restrictions. If thefit restriction is set to high, al de-
tections are required to closely match the internal curvature model. If
thefit restriction is set to standard (or medium), all detections are re-
quired to match the internal curve model, but with more tolerance for
error. Finaly, if thefit restriction is set to low, thefit toleranceis set
low enough that most detections will pass except those that no creature
could possibly create.

The pop filter isused to reject pop noise like static discharging, which
IScommon in electrostatic or capacitive sensors, especially when oper-
ated in high humidity. It isaso useful, for filtering out other false detec-
tions like rain drops hitting the detector.

Finally, thefilter bank provides a selectable set of filters that are based
on the scanned parameter measurements. These are primarily intended
to alow SCAN’R to be operated to search for a particular cal type, be-
cause they are very selective. Please see sections 3.8.1 and 3.8.2 for a
description of the parameters.



3.6.3 : Scan Results Window

The Scan Results Windows presents
the final results of the scan process-
ing. The Scan Results Window is
illustrated in figure 13.

At the very top of the window isthe
selection criteriafilter. Thisisthe
final filter in the selection process.
SCAN’ Ry, counts up the total num-
ber of detectionsin each file and
compares this to the selection crite-
ria. If the number of detectionsis
greater than or equal to the selection
criteriavaue, thefileis moved to the
“selected” filelist (top list). Other-
wise the fileismoved to the “failed”
filelist (bottom list).

Scan results are updated with each
filethat is processed either manually
(onefileat atime) or automatically
using the Action=>Scan All menu
selection. It aso includes counters
that track the total number of passed
files, the total number of detections
in all of the passed files, and the
number of failed files.
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Figure 13: Scan Results Window




3.6.3.1: Maintaining Call Archives

The Scan Results window provides flexible options to help maintain call
archives and minimize disk storage by weeding out bad files. The opera-
tor is given the option to delete, move, or archive select files or groups of
files.

The Scan Results window groups files into two lists, “passed” files and
“Failed” files. The passed filelist includes all files that meet the file se-
lection criteria specified in the Scan Setup window. Thefailed filelist in-
cludesdl filesthat did not meet the file selection criteria. Theselists are
update as SCAN'R finishes scanning each file. Once all the files has been
scanned, the operator has the option to delete, move, or archive selected
files.

3.6.3.1.1: Passed File Options

For passed files, the operator has three primary options. First, the opera-
tor can choose to archive the file. When archived, acopy of thefileis
placed in an archive directory. Second, the operator can choose to move
thefile. Inthiscase, thefileis actually moved from the origina directory
and placed in another directory. Finaly, if the operator decides that the
file should not have passed, the file can be manually moved over to the

The passed file option is selected us- Scan Results
ing the Scan Results Options menu. Options

The passed file option defaults to Ar- :
m v archive
Failed Files Miovve B,

chive. This setting preserves the
Files selected: 0

original file. To switch the setting to
Move click on Options->Passed
Files->Move asillustrated in figure
14. This setting will not preserve the

original file. Figure 14: Passed File Options




3.6.3.1.2 : Failed File Options

For failed files, the operator has two primary options. First, the operator
can chooseto delete the file. Note that the deleted files are actually
moved to Window's Recycle bin and won't actually be deleted until the
recycle bininemptied. Thisalowsfilesto be recovered if deleted acci-
dentally. Second, the operator can choose to movethefile. In this case,
the file is actually moved from the origina directory and placed in an-
other directory.

Thefailed file option is also selected
using the Scan Results Options
menu. Thefailed file option defaults
to Delete. This setting deletes the
origina fileand movesit to the Re-
cycle bin. To switch the setting to
Move click on Options->Failed
Files->Move asillustrated in figure

15. This setting not preserve the Figure 15; Passed File Options
original file.
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3.6.4 : Operation Timer Window

SCAN'’R includes an operation timer that can be used to perform periodic
or daily automated batch processing. Thisisanew powerful feature that
isincluded in version 1.5 and above. Because it isfully automated, the
operation timer enables SCAN’R to be employed in remote field collec-
tion and used in conjunction with SPECT’R or SPECT’R Mobile. This
provides a new data collection capability that is able to reduce data stor-
age requirements and extend the duration of unattended recording ses-
sions. For example, SCAN’R can prescreening the snapshot recordings to
weed out bad recordings and false detections and it can process the re-
cordings and save only the parameter sets which provides a huge reduc-
tion in the data storage requirement.

The operation timer is controller using the Operation Timer Window as
illustrated in Figure 16. The window contains three main sections; the
time and statusindicator section, the program activation method sec-
tion, and the operation programming section. These sectionswill be
discussed further on the next page.

Operation Timer
Current Time;  16:04:31 Local
Status: IDLE

Pragram Activation kethod

¥ Run scan at

’7
[~ Run scan every 1 mir

Scan  Input Directory Ouput File Archive Directory

v “Shapshots test] bt “templ
[w hemp test2 tut Whemps
Input... | <Mo directory selected: Dutput... | <Mofile selected: Arch... | <Moarchive selected:

Input... | <Mo directory selected: Dutput... | <Mofile selected: Arch... | <Moarchive selected:

1 T

Figure 16: Operation Timer Window



3.6.4.1: Time and Satus I ndicator

The time and status indicator section displays both the current time and
the current status of the operation timer. Thetimeisdisplayed in ether
UTC (universal coordinated time) or thelocal time. Anindicator isaso
displayed showing which timeis currently being displayed. The indicator
with either be UTC or Local. The status indicator displays the current
status of the operation timer.

Changing the time standard is ac-
complished using the Setup=>Time
Sandard menu option. Usethis
menu option to select the desired

File m Config  Acktion  Window  Help

Time Standard
Scan Setup...

time standard setting. The current Scan Results. ..
setting will be indicated with a —|  Qutput Format...
check-mark. |<Mo File Selected>

Figure 17: Passed File Options

3.6.4.2 : Program Activation Method

The program activation method section allows the operator to choose
how the operation timer will activate the programs. Programs can either
be activated beginning at a specific time each day or they can be acti-
vated periodically through the day with a specified interval.

To activate programs once per day, enter the start time in the time edit
box and click on the corresponding check box. To activate programs pe-
riodically throughout the day, enter the activation interval in minutesinto
the minutes edit box and click on the corresponding check box.

To disable the operation timer, uncheck both of the options.



3.6.4.3 : Program operation section

Scan  Input Directory Ouput File Archive Directory

YSnapshots test] tat
Stemp test? tat
Input... | <Modirectory selected:> Output... | <Mo file selected: arch... | <Ma archive selected:
Input... | <Ma directary selected: Output... | <Mafile selecteds drch.. | <Mo archive selected:

Figure 18: Program operation section

<l

“templ

“temp?

The program operation section alows the operator to select up to four
operations to run each time the operation timer triggers. The four pro-
grams are provided to allow SCAN’R to process the snapshots from up
to four AR125 ultrasonic receivers. Thisisthe maximum number of re-
ceivers that can be run using a single computer.

The program operation section, figure 18, is composed of four rows of
control entries. Each row includes an enable check box, an input direc-
tory selection, and output file selection, and an archive directory se-
lection.

The enable check box activates or deactivates each program. The pro-
gram is active only when the check box is checked. Clicking on the
check box changesits state. Each time the operation timer is activated it
will process al of the programs that are enabled in sequence, top to bot-
tom.

The input directory selection allows the operator to select the directory
that SCAN’R will process. The selection should be set to a directory that
Is being using to store snapshot recordings. To select adirectory, click on
the Input... button. Thiswill bring up adirectory browsing GUI. Navi-
gate through the directory structure to select the desired directory. Then
click on the OK button.



The output file selection alows the operatory to select adirectory and
file name to store all of the scan parameter results. To select an output
directory click on the Output... button and this will bring up a windows
file selection GUI. Use the GUI to select an output directory and then
type in the desired file name.

The file name specified in the output selection field is actualy just a base
file name, the beginning of afile name. SCAN’R will take thisfile name
and append atimetag to it to for the actual file name. In effect, the base
file name provides a convenient mechanism that the operator can use to
track sequences of files that are created each time SCAN'’R activates.
The file naming convention is <base file name>_ DyyyymmddThhmnss,

where: yyyy=year, mm=month, dd=day,
hh=hour, mn=minute, ss=second.

The archivedirectory selection allows the operator to select an optional
archive directory. Thisisadirectory that will be used to store all of the
good snapshots after they have been processed. Againthisdirectory is
optional. If an archive directory is chosen, then al of the good file will
be written to the archive directory and all of the bad files will be deleted.
Thisin effect will weed out all of the bad files. If no archive directory is
chosen, then all snapshot fileswill be deleted. Thisin effect will remove
all snapshot files from the disk and only retain the scan parameters.

To select an archive directory, click on the Arch... button to bring up a
directory browsing window. Browse through the window to select the
desired directory and then click on the OK button.

To deselect an archive directory, click on the Arch... button to bring up a
directory browsing window and then click on the Cancel button.



3.7 : Trace Window

In addition to the Sonogram, SCAN’R includes a Trace Window that al-
lows the operator to see atime versus frequency plot of the call sequence.
The timeis plotted horizontally with increasing time going from left to
right. The frequency is plotted vertically with increasing frequency going
from bottom to the top.

The Trace Window is somewhat analogous to the bat call display of the
Anabat;,, system (www.titley.com). The main differenceisthat the Trace
Window displays both the fundamental frequency component (green
trace) as well as the second harmonic (blue trace) if present.

The Trace Window is linked with the sonographic display so you can op-
erate it in conjunction with the main window. |If you double click the
mouse on one of the calls on the trace window, then the main window will
display the associated sonogram. Vice versa, if you double click on one
of the thumbnailsin the main window, than a cursor will highlight the as-
sociated call on the Trace Window.

The Trace Window is quite handy for maintaining a set of reference pa-
rameter calls. It allow an operator to select and save call reference se-
guences that can be used for call comparison and identification.

I —
oo
=

H[mSec] B36.72
Y[KHz]: 77755.10 Delete Selected | Save Selected | Append Selected | @

Figure 19: Trace Window




To bring up the Trace Window, select Window=>Trace... using the menu
options at the top of the main window. The trace window will initially be
blank, but it will update with call detections each time SCAN’R scans a
file.

Operating the Trace Window is fairly simple:

1) To select acal, smply point to the call using the mouse and
double click the left mouse button. Thiswill bring up a marker to
highlight the selected call and update the main display with the
corresponding sonogram.

2) To select agroup of calls, smply drag the mouse over the region
of interest while holding the left mouse buttons down. This will
highlight the entire area with a green background as shown in
figure 20.

Once a selection is made there are three options: A) you can delete the
selected entries from the call sequence by clicking on the Delete Selected
button, B) you can save the selected calls to anew file by clicking on the
Save Sdlected button, or C) you can append the selected calls to an exist-
ing file by clicking on the Append Selected button.

HmSec] 419.27
Y¥[KHz): BOE12.25

dx(mSec):  0.00
dr[KHz]: 367347

Delete Selected |

Save Selected |

Append Selected |

o

Figure 20: Trace Window




3.8: SCAN’'R Output file

If an output fileis specified, SCAN’ R writes the measured parameters to
the output file. The output fileis atab-delimited file that conforms to the
format selected by the Output For mat window (section 3.6.1).

The ability to provides detection parameter sets provides SCAN’R with
two important applications: 1) it can be used to generate call parameters
that can be used for bat species identification. 2) it can also be used to
compress and translate Time Expanded (TE) or Full Bandwidth (FB) de-
tector recording into a storage format that is compatible with the ZCD
(zero crossing detector) format that is employed in AnaBat;,/Anal 00kn.
This second function will allow mixed detector surveys by ensuring that
all results can be analyzed and archived to a common parameter format.

The output format is an open format that can be processed by second and
third party applications. In addition, the format can be read into standard
spreadsheet applications, such as Microsoft Excel as show in figure 20.

B3 Microsoft Excel - Book1
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Figure 21: Output File Loaded into Excel Spreadsheet



3.8.1: Analook;, compatible for mat

The Ana ook, base parameter set consists of sixteen (16) parameters
which are tab-delimited and written in the following order:

File Name
Start Time
Duration
Prev

Next
Fmax
Fmin
Fmean

Tk

Fk

Qk

Tc

Fc

S1

Sc

Qua

Name of input file

Call start time (msec)

Call duration (msec)

Time elapsed since previous detection (mMsec)

<Not used—set to 0>

Maximum frequency detected (KHZz)

Minimum frequency detected (KHz)

Mean or average frequency of call (KHz)

Time of the knee WRT the beginning of call (msec)
Frequency of the knee (KHz)

<Not used—set to 0>

Time of the characteristic WRT the beg call (msec)
The characteristic frequency (KHz)

Theinitial slope at the beginning of the call (OPS)
The characteristic slope in octaves per second (OPS)
<Not used-set to 0>



3.8.2 : SonoBat,,, compatible for mat

The SonoBat;,, base parameter set consists of twenty two (22) parameters

which are tab-delimited and written in the following order:

File Name Name of input file

Time Call start time (msec)

Duration Cadl duration (msec)

prev Time elapsed since previous detection (msec)
Fmax Maximum frequency detected (KHz)

Fmin Minimum frequency detected (KHz)

Bandwidth Total BW [Fmax - Fmin] (KHz)

Dom. Freq Frequency at strongest sound pressure level (KHZz)
Dom F Loc Location of Dom. Freq (percent of total duration)
High Fc High end of characteristic (KHz) [Similar to Fk]
Low Fc Low end of characteristic (KHz) [Similar to Fc]
Slope Global slope of the call (KHz per msec)

Th Time of the heel or High Fc (percent of duration)
Su Upper slope [start to High Fc] (KHz per msec)
Sl Lower slope [High Fc to Low Fc] (KHz per msec)
Heel Flag 1if hedl isobvious

H1 Fundimental frequency (KHz) *

H2 2nd harmonic frequency (KHz) *

H3 <not used, set to 0>

H4 <not used, set to 0>

H5 <not used, set to 0>

H6 <not used, set to 0>

* Note that the marker frequencies H1 and H2 are only used if SCAN’R detects the
presence of a second harmonic. Inthisevent, H1 and H2 are set to frequencies at the
point in the call were the 2nd harmonic is strongest. Otherwise they are both set to
zero.



3.8.3: Optional Parameters

Either base parameter set can be enhanced with up to three (3) additional
parameters. These are also tab-delimited and are appended to the base
parameter set in the following order:

SPL : Peak Sound Pressure Level (SPL dB)
Curv : Curvature measurement
Fit : Curvaturefit error (RMS error in Hz)

The SPL parameter isvalid only when using calibrated detectors like
the BAT AR125. Otherwisg, it can only be considered as relative signal
strength measurement that may vary from detector to detector.

The Curvature measurement is a novel way to characterize the shape of
bat calls. Thisideawas described by Simon Jolly in the Australasian
Bat Society Newsletter in 1997. The basic premiseisthat bat calls can
me modeled by the equation:

frequency ~=time”  where Pisan integer value
SCAN’R employs this model, but enhances it to allow afractiona expo-
nent (P). SCAN’R also adopts a new convention to easily identify up-
ward curving and downward curving calls.
If the call isdownward curving Pis positive and:
frequency ~= time " where Pis an fractional value
If the call isupward curving Pis negative and:

1(-P)

frequency ~= time where Pis an fractional value

Thus for any valueof P, Pand -P reflect the same basic shape, but P
curves downward while —P curves upward.



Finally, the curvefit error parameter is a measurement of how much
error exists between the curvature model and the actual shape of the call.
The measurement is the Root Mean Squared (RMS) value calculated as
the difference between the frequency calculated as a function of the
model compared against the frequency measurements of the data. The
units are RMS Hertz.

Low values of curvefit error mean that the data is a closer match to the
model. Higher values mean that the datais NOT fitting the model. Asa
generd rule, SCAN’ Ry, expectsto see an error less than 100 Hz RMSto
trust that the data fits the model.



4.0 : Further Information

For further information or trouble shooting, please contact
us or visit our web site.

Web:  www.binaryacoustictech.com
E-Malil : info@binaryacoustictech.com
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